z MITSUBISHI
ELECTRIC

DIGITAL RECORDER
USER’S MANUAL

MODEL

DX-TL4716U

THIS INSTRUCTION MANUAL IS IMPORTANT TO YOU. PLEASE READ IT BEFORE USING YOUR DIGITAL RECORDER.



RISK OF ELECTRIC SHOCK
DO NOT OPEN

WARNING: TO REDUCE THE RISK OF ELECTRIC SHOCK,

DO NOT REMOVE COVER (OR BACK)
NO USER-SERVICEABLE PARTS INSIDE

REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

The lightning flash with arrowhead symbol, within
an equilateral triangle, is intended to alert the user
to the presence of uninsulated “dangerous voltage”
within the product’s enclosure that may be of
sufficient magnitude to constitute a risk of electric
shock.

The exclamation point within an equilateral triangle
is intended to alert the user to the presence of
important operating and maintenance (servicing)
instructions in the literature accompanying the
appliance.

WARNING:

TO PREVENT FIRE OR SHOCK HAZARD, DO NOT EXPOSE THIS APPLIANCE TO RAIN OR
MOISTURE.

CAUTION:

TO PREVENT ELECTRIC SHOCK DO NOT USE THIS (POLARIZED) PLUG WITH AN
EXTENSION CORD, RECEPTACLE OR OTHER OUTLET UNLESS THE BLADES CAN BE
FULLY INSERTED TO PREVENT BLADE EXPOSURE.




DANGER D’ELECTROCUTION
NE PAS OUVRIR

AVERTISSEMENT: POUR ELIMINER TOUT RISQUE D’ELECTRO-

CUTION, NE PAS OUVRIR LE COUVERCLE
(OU LA PARTIE ARRIERE). AUCUNE PIECE
REPARABLE PAR L'UTILISATEUR NE SE
TROUVE A LINTERIEUR.

POUR TOUTE INTERVENTION D’ENTRETIEN
OU DE REPARATION SE CONFIER AUX TECH-
NICIENS QUALIFIES.

La fleche symbolisant I'éclair dans un triangle équilateral
a pour objet de tirer I'attention de I'utilisateur sur le fait, qu’
il y a des “tensions dangereuses” non-isolées a l'intérieur
de I'enceinte du produit qui peuvent étre suffisamment
importantes pour conduire au risque d’électrocution.

Le point d’exclamation au sein d’un triangle équilateral a
pour objet de tirer I'attention de I'utilisateur sur le fait qu’

il y a des instructions de mise en service et d’entretien (de
réparation) dans les fiches descriptives de I'appareil qui
doivent obligatoirement étre respectées.

/ N

AVERTISSEMENT:

AFIN D’EVITER TOUT RISQUE D’INCENDIE OU D’ELECTROCUTION, NE PAS EXPOSER CET
APPAREIL A LA PLUIE NI A LHUMIDITE.

ATTENTION:

POUR PREVENIR LES CHOCS ELECTRIQUES NE PAS UTILISER CETTE FICHE POLARISEE
AVEC UN PROLONGATEUR, UNE PRISE DE COURANT OU UNE AUTRE SORTIE DE
COURANT, SAUF SI LES LAMES PEUVENT ETRE INSEREES A FOND SANS EN LAISSER
AUCUNE PARTIE A DECOUVERT.
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Important safeguards

PLEASE READ ALL THESE INSTRUCTIONS REGARDING YOUR RECORDER AND RETAIN FOR FUTURE REFERENCE.
FOLLOW ALL WARNINGS AND INSTRUCTIONS MARKED ON THE RECORDER.

Read Instructions
All the safety and operating instructions should be
read before the appliance is operated.

Retain Instructions
The safety and operating instructions should be
retained for future reference.

Heed Warnings
All warnings on the appliance and in the operating
instructions should be adhered to.

Follow Instructions
All operating and use instructions should be
followed.

Cleaning
Unplug this product from the wall outlet before
cleaning. Do not use liquid or aerosol cleaners.

Ventilation

Slots and openings in the cabinet are provided for
ventilation and to ensure reliable operation of the
product and to protect it from overheating, and
these openings must not be blocked or covered.
This product should never be placed near or over
a radiator or heat register. This product should
not be placed in a built-in installation such as
a bookcase or rack unless proper ventilation is
provided or the manufacturer’s instructions have
been adhered to.

10. Power Sources

This product should be operated only from the
type of power source indicated on the marking
label. For products intended to operate from
battery power, other sources, refer to the operating
instructions.

Use a damp cloth for cleaning. 11. Grounding or Polarization
This product is equipped with a 3-wire grounding-
Attachments type plug, a plug having a third (grounding) pin.
Do not use attachments not recommended by This plug will only fit into a grounding-type power
the product manufacturer as they may cause outlet. This is a safety feature. If you are unable
hazards. to insert the plug into the outlet, contact your
electrician to replace your obsolete outlet. Do not
Water and Moisture defeat the safety purpose of the grounding-type
Do not use this product near water — for example, plug.
near a bath tub, wash bowl, kitchen sink, or
laundry tub, in a wet basement, or near a 12. Power-Cord Protection
swimming pool, and the like. Power-supply cords should be routed so that
they are not likely to be walked on or pinched
Accessories by items placed upon or against them, paying
Do not place the product on an unstable cart, particular attention to cord at plugs, convenience
stand, tripod, bracket, or table. The product receptacles, and the point where they exit from
may fall, causing serious injury. Any mounting of the appliance.
the appliance should follow the manufacturer’s
instructions, and should use a mounting accessory  13. Lightning
recommended by the manufacturer. For added protection for this product receiver
during a lightning storm, or when it is left
An appliance and cart combination should be unattended and unused for long periods of time,
moved with care. Quick stops, excessive force, unplug it from the wall outlet. This will prevent
and uneven surfaces may cause the appliance damage to the product due to lightning and power-
and cart combination to overturn. line surges.
14. Overloading
Do not overload wall outlets and extension cords
as this can result in a risk of fire or electric shock.
15. Object and Liquid Entry

Never spill liquid of any kind on the product.




16. Servicing 18. Replacement Parts
Do not attempt to service this product yourself as When replacement parts are required, be sure the
opening or removing covers may expose you to service technician has used replacement parts
dangerous voltage or other hazards. Refer all specified by the manufacturer or have the same
servicing to qualified service personnel. characteristics as the original part. Unauthorized
substitutions may result in fire, electric shock or

17. Damage requiring Service other hazards.

Unplug this product from the wall outlet and refer
servicing to qualified service personnel under the 19. Safety Check
following conditions: Upon completion of any service or repairs to this
(@) When the power-supply cord or plug is product, ask the service technician to perform
damaged. safety checks to determine that the product is in
(b) If liquid has been spilled, or objects have fallen safe operating conditions.
into the product.
(c) If the product has been exposed to rain or 20. Heat
water. The product should be situated away from heat
(d) If the product does not operate normally by sources such as radiators, heat registers, stoves,
following the operating instructions. Adjust or other products (including amplifiers) that
only those controls that are covered by product heat.
the operating instructions as an improper
adjustment of other controls may result in  21. This equipment does not provide connection
damage and will often require extensive work for used with outdoor or cable distribution
by a qualified technician to restore the product systems.
to its normal operation.
(e) If the product has been dropped or the cabinet
has been damaged.
(f) When the product exhibits a distinct change in
performance, this indicates a need for service.

[ NOTE )
This equipment has been tested and found to comply with the limits for a Class A digital de-
vice, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference when the equipment is operated in a commercial en-
vironment. This equipment generates, uses, and can radiate radio frequency energy and, if
not installed and used in accordance with the instruction manual, may cause harmful interfer-
ence to radio communications. Operation of this equipment in a residential area is likely to
cause harmful interference in which case the user will be required to correct the interference at
his own expense. Changes or modifications not expressly approved by the party responsible

9 for compliance could void the user's authority to operate the equipment. y
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NOTE
THIS CLASS A DIGITAL APPARATUS COMPLIES WITH CANADIAN ICES-003.
CET APPAREIL NUMERIQUE DE LA CLASSE A EST CONFORME A LA NORME NMB-003 DU CANADA.
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Caution and care

| HEAVY OBJECTS SHOULD NEVER BE PLACED ON THE UNIT (E.G., MONITOR)

NEVER REMOVE THE TOP COVER AND TOUCH OR INSERT ANY OBJECT INSIDE THE UNIT
Touching the inside of the cabinet or inserting foreign objects of any kind through the disc loading slot or ventilation holes not
only creates a safety hazard but can also cause extensive damage.

PROTECT THE POWER CORD

Damage to the power cord may cause fire or electrical shock. If the power cord is damaged, turn OFF the MAIN switch and
carefully replace it with a new power cord.

Do not move this product with the power-on as the built-in HDD may be damaged. If you need to move the product, turn the
unit OFF and disconnect power from the unit. Confirm that more than one minute have passed since the power cord and the
connecting cords were disconnected, then move this unit. Make sure to take the disc out and close the disc loading slot.

UNPLUG THE POWER CORD DURING A LONG ABSENCE
Turn off the power and unplug the power cord during a long absence.

MAINTAIN GOOD VENTILATION

Do not obstruct the many ventilation holes on the unit. For maximum ventilation, leave some space around the unit and place
the unit on a hard level surface only, and ensure it is not covered during use. Heavy objects should never be placed on the
unit.

WHEN NOT IN USE
When not in use, always eject the disc and turn OFF the MAIN switch.

CABINET CARE
Never use petroleum-based cleaners. Clean with a soft cloth moistened with soap and water and wipe dry.
PVC cables or leads should not be left in contact with the cabinet surface for long periods.

INSTALLATION LOCATION

For excellent performance and lasting reliability install in a location that is:-

1. Well ventilated, out of direct sunlight and away from direct heat.

2. Asolid vibration-free surface.

3. Free from high humidity, excessive dust and away from magnetic fields.

4. Please ensure that the ventilation fan located on the unit’'s back panel is not blocked.

UNSUITABLE LOCATIONS

Placing the unit in the following places might shorten the product life:

» Extremely cold places, such as refrigerated warehouses and ice houses

» Places where excessive hydrogen sulfide is likely to be generated, such as hot-springs areas
» Places or locations with salt air environment.

NO OBJECTS FILLED WITH LIQUIDS, SUCH AS VASES, SHALL BE PLACED ON THE APPARATUS.
DO NOT PLACE HEAVY OBJECT ON THIS UNIT.

DO NOT STEP ONTO THIS UNIT.

DO NOT PLACE ANY OBJECTS IN FRONT OF THE DISC LOADING SLOT.

The unit may drop or fall by losing its balance. It may cause injury or failure of the unit.

WARNING: TO PREVENT FIRE OR SHOCK HAZARD, DO NOT EXPOSE THIS APPARATUS TO RAIN OR MOISTURE.
THIS APPARATUS MUST BE GROUNDED.




e
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WARNING:

The supplied power cord is used for 120 V only. Never connect to any outlet or power supply having a different

voltage or frequency.

~
Notice about construction of the surveillance system using this unit

» This unit can be controlled by the external devices via RS-232C terminal or LAN terminal. This unit can also be used to
control external devices via external terminal, RS-422/485 terminal, or RS-232C terminal. Owning to these functions,
this unit flexibly applies to the high grade security system, but the whole surveillance system may be affected by the
malfunction of this unit or the external devices depending on the setting contents of this unit, the connection with the
external devices, or combination between this unit and the external devices.

*  When configuring a surveillance system using this unit, it is recommended to confirm first that this unit operates
normally with the other devices connected.

» ltis recommended to copy or back up the important recorded contents.

» Damages rising out of any operational error of the surveillance system or loss of the recorded data or any other
damages because of any user malfunction of this unit are not covered.

* Do not use the notification function of this unit for making critical judgement nor any purpose related to human lives.

* When this unit cannot recognize the external device which is being used for recording due to the power failure,
decreased voltage, or other failures, the recording point may be moved to the internal HDD of this unit or the other
external HDD. To prevent occurence of such problem, it is recommended to use uninterruptible power supply.

» If the power plug is disconnected or the breaker switch is turned off during recording, HDD may be damaged or
playback of recorded data may become impossible.

If the breaker switch is turned on and off everyday, set the timer recording to be performed only for the period that the
breaker is on and do not turn off the breaker during recording.

» Itis recommended to check periodically that recording is perfomed successfully by playing back the recorded data.

There may be cases when the unit's built-in motion detection function does not operate properly due to external
condition, video input signal, or other factors.

The user will not be indemnified for problems (e.g., recording failure or playback failure) that occur with either the unit or
a connected device during operation. It is recommended to back up the important recordings regularly as a precaution
against possible breakdowns and accidents.

Recordable time and product warranty
Continuous recordable time and the estimated time displayed on the menu screen indicate the continuous time of
recording operation of this unit. They indicate the period neither for product warranty nor that for reliability of used parts.

+ This unit uses a built-in HDD, which is a precision device. Handle this unit with sufficient care.

» Do not subject this unit to vibrations or shocks. This may cause trouble specially when the power of the unit is turned
on or when the HDD is being accessed, and sufficient care is required.

* Do not disconnect the power plug while the power of the unit is turned on or while recording or playing.

» For early detection of faults, we recommend that you request inspection once a year.

The HDD and cooling fan of this unit are driving parts. For stable recording, it is recommended that both of these parts are
replaced every 30,000 hours.
(This interval is for reference purpose only and does not indicate the warranty period of the parts.)

g

DISCLAIMER

In any event, Mitsubishi assumes no responsibility or reliability for the following:

1. Disassembly, repair, or alteration of this unit by user or installer.

2. Failure or breakdown in or damage to this unit resulting from misuse or careless handling by user or installer.

3. Inconvenience or damages arising out of inability to display or record pictures due to any reason or cause other than
breakdown or failure in this unit.

4. Failure in this unit due to combination with other equipment manufactured by a third party or inconvenience or
damages resulting from such failure.

5. Inconvenience, damages, or claims arising out of breakdown in this unit or loss of recorded video data due to
replacement of the built-in HDD by user or installer.

6. Inconvenience or damages arising out of breakdown in this unit or inability to display or record pictures due to natural
disaster including earthquake and storm.

7. Inconvenience, damages, or claims arising out of breakdown in this unit or loss of recorded video data due to impact
or vibration to the built-in HDD or an environmental factor such as temperature at the installation site.

8. Demand for damages or other claim of infringement of privacy if the pictures monitored or recorded by user become
public or are used for any purpose other than surveillance for whatever reason.

J

( CLASS 1 LASER PRODUCT

)

Beginning



Caution and care (continued)

INSTALLATION LOCATION AND HANDLING

Place this unit horizontally and in a stable place. If this unit is not placed correctly and used in an unstable place, the unit
may be damaged such as removal of the DVD/CD disc.

Do not place this unit close to other electronic or magnetic equipment. This will avoid video and audio distortion.

When a monitor and this unit are placed vertically, the pictures may be distorted or DVD/CD disc may not be ejected.

Do not let stick your hands into the disc loading slot. You may get your hand caught in the slot and may got injured. If you
get your hand caught, do not get out of the slot by force. Contact your dealer after turning off the power and disconnecting
the plug.

DVD/CD DISC

.

Do not use the disc cracked, deformed or repaired with adhesive. The disc may fly into pieces and cause injury.

Do not touch the playback surface when holding the disc.

When dew condensation occurs on the disc, wipe the surface off before use.

Dirt such as fingerprints or dust causes the deterioration of the picture quality and audio quality. Gently wipe the DVD/CD
disc from the center to the outside with a soft cloth.

When the disc is very dirty, soak a soft cloth with water and screw water of it, wipe off the dirt lightly, then wipe with a dry
cloth.

Do not use solvent such as benzine and thinner, a record cleaner, and static-stopper. They may damage the disc.

Do not use the disc described below. They may damage the disc itself or this unit.

Discs on which a piece of paper or sticker is put, or a disc damaged.

Discs which the label is peeled or a disc with oozing.

Discs cracked, deformed, or repaired with adhesive.

Store the disc in the specified casing, avoiding the following places.

Places where it will be subjected to direct sunlight.

Places with excessive dust.

Places where it will be subjected to high temperatures or high humidity.

DVD movie (cinema) or personal recorded picture cannot be played back on this unit. Only the pictures recorded on this
unit can be played back.

Do not use the disc which has been used on the personal computer, failed to be copied, or stopped during copying due to
the power failure because they may cause malfunction of the unit.

Although you can copy the data on DVD/CD with this unit and playback that data on the personal computer using the
supplied application software, not all the personal computers or DVD/CD drives are ensured for proper playback of such
data.

MAINTENANCE OF THE LENS FOR RECORDING/PLAYBACK (LASER PICKUP)

When any dust adheres on the lens for recording/playback, the picture may be distorted or the audio may skip. Also normal
recording or playback may not work. Ask your dealer how to correct this problem.
Be careful, do not use the commercial lens cleaning disc, they may damage the lens.

PRECAUTION CONCERNING EXTERNAL DEVICE

The various external HDDs can be connected to this unit in order to expand the memory or to use as the copy device.
However, during recording or playing back a picture at high rate, some pictures may be missed due to the slow rate of data
transfer or the slow speed of response from the external device connected. Be sure to check the operation sufficiently in
advance.

Do not use the power control function of the external device which uses bus power of this unit.

The external device to be used may be unsuitable for the operation you want to set. It is recommended to consult your
dealer when using the external device.
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Note

Thank you for purchasing Mitsubishi digital recorder DX-TL4716U (hereinafter referred to as “Product”). Before using this
Product, please be sure to read the following Software License Agreement with regard to the software contained in this
Product (hereinafter referred to as “Licensed Software”). By using this Product. you are agreeing to be bound by the
terms and conditions of the following Software License Agreement.

This Product contains software programs that are covered by GNU General Public License or GNU Lesser General Public
License. Such software programs are excluded from Licensed Software and not covered by the following Software License
Agreement. For the terms and conditions for use of the software programs covered by GNU General Public License or GNU
Lesser General Public License, please see “Notice about software to which GNU GPL/LGPL is applied™.

In addition, this Product contains “Apache” and “OpenSSL (including “Original SSLeay” library).” These software programs
are also excluded from Licensed Software and not covered by the following Software License Agreement. For the terms and
conditions for use of these software programs, please see “Notice about Apache software™ and “Notice about OpenSSL
software”™.

» o« ” o«

Each of “Berkeley Database,” “agetty,” “expat,” and “zlib” contained in this Product is other open source software. These
software programs are excluded from Licensed Software and not covered by the following Software License Agreement. For
the terms and conditions for use of these software programs, please see “Notice about other open source software™.

*

The documents of “Notice about software to which GNU GPL/LGPL is applied,” “Notice about Apache software,” “Notice
about OpenSSL software,” and “Notice about other open source software” are contained (in the format of electronic
files as notice_ GPL_LGPL_ja.pdf, notice_Apache_ja.pdf, notice_OpenSSL_ja.pdf, and notice_other_ja.pdf) in the
“OpenSoft_License” folder in the CD supplied with this Product.




Software License Agreement

This Software License Agreement (“Agreement”) is an agreement between you (“‘User”’) and Mitsubishi Electric Corporation
(“Licensor”) with regard to the license to use Licensed Software.

Article 1 (Grant of license)
Licensor hereby grants to User a nonexclusive, nontransferable license to use Licensed Software.
Article 2 (License)

1. The license to use Licensed Software granted hereunder shall mean the User’s right to use Licensed Software solely
on this Product. User is hereby allowed to refer to the descriptions and instructions related to Licensed Software
contained in the user’s guide of this Product to the extent necessary for use of such Licensed Software.

2. User shall not reproduce, copy, or modify, in whole or in part, or make addition or alteration to Licensed Software and
pertinent documents.

3. User shall use Licensed Software in accordance with the operating instructions described in the user’s guide.
Article 3 (License conditions)

1. User shall not transfer to any third party the license stipulated in the preceding article.

2. User shall not disassemble, decompile, or otherwise analyze the source code of Licensed Software.
Article 4 (Ownership of Licensed Software)

All and any rights including copyrights related to Licensed Software and pertinent documents shall be owned by
Licensor or the original right holder who granted to Licensor the right to sublicense Licensed Software (hereinafter
referred to as “Original Right Holder”). User shall not own any rights other than the license granted hereunder with
regard to Licensed Software and pertinent documents.

Article 5 (Disclaimer)

Licensor and Original Right Holder shall make no warranties whatsoever with regard to Licensed Software and have
no liability for any damages suffered by User or any third party arising out of User’s execution of the license granted
hereunder, except in cases where any applicable laws are extended.

Article 6 (Responsibility toward third party)

Any issues related to intellectual property rights, including but not limited to rights of privacy, copyright, and
patent, involving any third party arising out of User’s use of Licensed Software shall be settled by User on its own
responsibility, and Licensor shall have no responsibilities for such issues.

Article 7 (Confidentiality)

User shall keep secret the details of Licensed Software and pertinent documents provided hereunder and the
contents of this Agreement that are unknown publicly and shall not disclose or leak such details and contents to any
third party without consent of Licensor.

Article 8 (Termination)

In case of either of the following events, Licensor may terminate this Agreement immediately and may claim against
User for resulting damages it suffers.

(1) User’s violation of any provision of this Agreement.

(2) Occurrence of filing against User for seizure, provisional seizure, provisional injunction, or other forcible
execution.

Article 9 (Disposal of Licensed Software)

If this Agreement is terminated pursuant to the preceding article, User shall dispose of Licensed Software, pertinent
documents, and any copies thereof in its possession within two weeks after termination hereof and shall provide
Licensor with a written certification of such disposal.

Article 10 (Update of Licensed Software)

If User updates Licensed Software using an update CD supplied or sold by Licensor or any other means, this
Agreement shall remain applicable to the updated version of such Licensed Software, unless Licensor provides
additional separate terms and conditions for using the updated version of such Licensed Software.

Article 11 (Miscellaneous)

1. If any provision of this Agreement is determined to be invalid by law, the remaining provisions hereof shall remain
valid and enforceable.

2. If any doubt arises in relation to matters not defined herein or interpretation hereof, Licensor and User shall discuss
such doubt and attain a solution in a faithful manner.
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How to set the menus

B Setting the menus

The operations of this unit can be set via a menu displayed on OUTPUT A monitor. You can select and set the menu by using
the buttons on the front panel or using a USB mouse connected to the unit. When using the front panel buttons, the numbers
1-16 (camera number buttons) and letters A to E (SPLIT screen buttons) represent the GUI button of the menu screen.

@ The menu can only be displayed through OUTPUT A monitor. The menu cannot be displayed through OUTPUT B monitor.

4@ Setting the menu using a mouse

@ Use the standard USB mouse which has left and right

Wheel buttons as illustrated to the left.
j step]. Use the left and right mouse buttons to set the
Left button ——Right button menu.

Mouse

4 Setting the menu using the front panel buttons

— = = stepq.

HELP SETUP  SEARCH  TIMER

DIGITAL
LOCK  TRIPLEXPB BOOKMARK ~ ZOOM

CAMERA ZOOM
C

FOCUS

2]
IRIS
mC )| [
PRESET
B PTZ

AUTO PAN
B @ M-DET Rl v
3 AREA SET UP

M-DET
DOT ON/OFF

)
S
£

Click the left button to open the menu or select
a needed item, etc.

Click the right button to set the active area for
motion detection function.

The wheel on a mouse does not work with this
unit.

Use the SET UP button, camera number buttons,
and the SPLIT screen buttons (A to E) to set the
menu.

Press the SET UP button to display the menu
screen.

Press the camera number buttons (1 to 16)
and the SPLIT screen buttons (A to E) to open
each menu or to select the needed item.




4 Displaying a menu screen

step]. Press the SET UP button or click the left button on
the mouse to display a menu.
*  The <User Menu> appears.
» To open other menu, press the D button or left-
click on “Next ».”

HELP SETUP  SEARCH  TIMER

DIGITAL

LOCK ZOOM

—J

© When you use a mouse, click the following area to

operate.
Click this area

User Menu 100 000 000

El Search ‘ Iz\ Copy ‘ lz\ Information ‘
[5]Protect Data | [ [ PTZ Control |

4@ Closing a menu screen

CAMERA Z00M

=

step], Press the E button or left-click on the “Exit” to close

“m: E the menu.
m; EP @ You cannot close the menu by pressing the SET UP
mwz C button on the unit.
Setup Menu 200 000 000
1 | Recording l IT’ Timer l IT’ Motion Det l m Next p> l
IT’ System l I?’ Menu Data l Bm

@ Selecting an item

step1. Press the front panel button of the needed item
number or left click on the needed item.
* The selected item menu opens.
» Select an item and press the number, or click
on the menu to open the item.

M-DET
DOT ON/OFF

Exit

Reset to Factory Setting

On Screen Display Setting

Multiplexer Setting

Password Setting

Rear Terminal Setting

Menu Language Selection

affnfefs oo [~ |(m

M

Time/Date Setting

System l EI Menu Data : Exit

IS

How to set the menus
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How to set the menus (continued)

4 Inputting numbers

——Number input area

Time Date Setting 241 000 000
Time Date Setting
Set time and date.
Day Light Saving Setting
[A] Auto | [D] set> |

@ Setting parameters

CAVERAZOOM  TILTA

==} A
=0 SEQUENCE
E=2)

TILTY
DUTF)‘\JT
7
&= s
PTZ

AUTO PAN
£

241 000 000 |

Time Date Setting
Time Date Setting
Set time and date.
Day Light Saving Setting
[A] Auto | [D] set> |

Setting or selecting area

Using the front buttons of the unit:

step]1. Press the camera number buttons (0 to 9) to input
and use that number.
* The number displayed in red can be changed.

step2. To move to the next input area, press the 16 button.

To go back to the previous area, press the 14
button.

Using a mouse:
step]. Left-click on the number in red until the needed
number appears.

To change another area, left-click on the needed
area or left-click € or P.

step]. Press the A button or left-click on the parameter box
until the item to be set appears.
« For some items, more detailed setting is
required. In this case, an item such as “D(Set
>)" is displayed. If necessary, press the D
button or left-click on the “Set >” to set more
details.

© When you close the menu, press the E button or left
click on “Return” or “Exit.”

@ You cannot close the menu by pressing the SET UP
button on the unit.




B Symbols in the menus

Motion Search (Main - Normal) Q16 000 000 J
Camera Select Al 1 1 A_] 15|
| —
Search Start Position m
Olde

[[1] - [o[1] - [2[o[o]e] [o]o]: [o]o] - [o]o] [sa[«a] [36]>-}—

Setup date search starts from.

Motion Detection Settings B
Same as Recording Setting I?’ Motion A l IH’ same l

m Search l I?’ Return l

Up button
Menu address
Help button
Down button

Left button
Right button

Some symbols appear in the menu screens. The meanings are as follows.

{}VAE

Menu address A unique number for each menu page. You can go directly to each menu page by inputting the menu ad-

Left) When you press the 14 button or click this symbol, the item to be set shifts to left.

(
(Right)  When you press the 16 button or click this symbol, the item to be set shifts to right.
(

dress number using the front buttons of the unit.

For example, when opening the <Motion Search> menu, press the SET UP button and then press the cam-

era number button in the order of 1, 6.

(Help) When you press the HELP button or click this symbol, the detailed information on the menu appears.

Up) When you press the 11 button or click this symbol, the value of selected item increases.

(Down)  When you press the 15 button or click this symbol, the value of selected item decreases.

How to set the menus
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Setting the time and date

B Time/Date Setting

This function is used to set the present date, time, and auto
daylight saving. Auto daylight saving function is used to auto-
matically gain an hour for the specified time period.

Start/end time of the auto daylight savings can be checked
and if needed, changed.

@ Before you start recording, accurately set the present
date and time.

O The recording and playback are not performed properly
when the clock of this unit does not run. Check that the
clock of this unit is running before operation.

1 | Time/Date Setting

step]. Set the present month, date, year, hour, minute, and
second.

\—{ D | Day Light Saving Setting

step2. Select the desired setting for daylight saving.
Auto: Automatically adjust forward or back an
hour for the time period set in the <Day Light
Saving Setting>.
Off: Auto daylight saving function is not used.

step3. Date and time of Auto Day Light Saving Setting can
be adjusted as needed.

C) The time is indicated using the 24-hour system.

© This unit uses 4 digits to display the year. The available
display range is 37 years between January/01/2001 to
December/31/2037. The unit is also equipped with a
function to automatically calculate leap years. The year
returns to 2001 after December/31/2037.




Using the basic multiplexer functions

H Basic multiplexer functions

This function is used to activate multiplexer functions using
the buttons on the front panel.

— DIGITAL ZOOM button

Camera number buttons =

a

]

RECISTOP
EARRM COPY1 COPY2 O5TQ

O o o

T U

o
TITA

=9 Bszmmci

5 1 iy MDET 0

LT¥ ureur | ot onore
378
o

[Hn] REVPLAY
¢ Moloio £
=
S5 Sm—
)

SPLIT screen buttons -

SEQUENCE button -
OUTPUT A/B button -~

Move buttons =

4 Multiplexer buttons

1.

Camera number buttons (1 to 16)

Displays the picture supplied from the cameras connected
to CAMERA IN terminals 1 to 16 on the rear panel in the
single screen display.

© Pictures can be displayed even if the camera is not set to

record.

SPLIT screen buttons

Each time the button is pressed, displays the split screen
in the following order.

SPLIT4 (EH) button : SPLIT 4a>SPLIT 4b~>
SPLIT 4c>SPLIT 4d—>SPLIT 4a
)

SPLIT9 (BH) button : SPLIT 9a>SPLIT 9b~>

SPLIT 9a->¢ » »
SPLIT10 (E£) button :  SPLIT 10a=>SPLIT 10b—>
SPLIT 10a—>¢ ¢«
SPLIT13 (EH) button : SPLIT 13a—>SPLIT 13b—>
SPLIT 13a>¢ -
SPLIT16 (E#) button : SPLIT 16 screen

SEQUENCE button

Displays the sequential screen in the split screen or
the single screen display. Make the detailed settings of
this display in the <Multiplexer Setting> (Setup Menu
- System). Sequential display does not appear during
playback.

© The sequential display is cancelled when you press the

SEQUENCE button again or display a different type of
split screen or single screen.

© Pressing the OUTPUT A/B button on the front panel

switches the multiplexer video output. When OUTPUT Ais
selected, the button light indicator is off. When OUTPUT
B is selected, the button light indicator is on, and camera
number buttons, SPLIT screen buttons, and SEQUENCE
button are operated for the monitor screen connected to
the OUTPUT B connector. Pressing the OUTPUT A/B
button again switches the multiplexer output to OUTPUT A.

. DIGITAL ZOOM button

Pressing this button in single screen mode displays the
screen at 100%. At this time, the magnification centre
point (X) appears. Pressing the button again switches
the magnification to 200%, and then 400%. By pressing
the MOVE buttons, the centre point moves vertically or
horizontally.

When the DIGITAL ZOOM button is pressed. camera
number buttons 11, 14, 15. and 16 move the “X” in the

screen.

Basic operations
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Controlling the camera

This function is used to control the cameras connected via [l PTZ control using the front panel buttons
RS-232C or RS-422/485 terminal.
step]. Press the camera number button of the PTZ camera

B PTZ control using the menu number to be controlled and display the picture in
the single screen display.
step2. Press the PTZ button.
* The unit switches to PTZ mode and the button
6 lights up. “PTZ” appears on the LCD display on

the front panel during PTZ mode.

01-01-2006 00:00:00
PTZ

* The camera number to be controlled appears on
the LCD display on the front panel.

— 1] Go to PTZ Control

step 2

Zoom, iris, focus adjustment, AutoPan

step
Preset

—| 2 |Select PTZ Camera

01-01-2006 00:00:00
PTZ CAM1

stepd. Control the camera.
Tilt: Press the TILT a button to tilt the camera in
the upward direction. Press the TILT ¥ button to

R

step]. Pan or tilt the PTZ camera connected. tilt the camera in the downward direction.
» Click the gray area by using the mouse to adjust Pan: Turn the SHUTTLE ring to the right to pan
the camera angle. the camera in the rightward direction. Turn the

SHUTTLE ring to the left to pan the camera in the
leftward direction.

T adjusts the camera angle
Camera zoom: Press the CAMERA ZOOM button

in the upward direction

adjusts the adjusts tgggle and then turn the JOG dial to the left (wide) or

camera angle in the rightward right (tele) to adjust the camera zoom.

g the leftward direction Focus: Press the FOCUS button and then turn the
irection -«—— —

JOG dial to the left (far) or right (near) to adjust the

focus of a camera.

| Iris: Press the IRIS button and then turn the JOG

¢ adjusts the camera angle _d!al to the left (close) or right (open) to adjust the
in the downward direction iris of a camera.

Preset: Press the PRESET button and then press

the camera number buttons within 3 seconds to

step2, Adjust zoom, iris, and focus. And activate auto pan.

step3, Preset the viewing points 1 to 16. preset the viewing points. Up to 16 points can be
* The preset points are registered to the PTZ set.
camera for auto pan function. Auto pan: Press the AUTO PAN button to activate

4. Switch th ber to b irolled the auto pan function of the camera.
step4, Switch the camera number to be controlled. , , ,
- The camera number to be controlled appears on (1) During PTZ operation using front panel buttons, POWER

the LCD display on the front panel. button and functions related to playback do not work. Fur-
thermore, menus cannot be displayed.

01-01-2006 00:00:00
PTZ CAM1

© <PTZ Control> can be set using the mouse only. You can-
not set it using front panel buttons.




Recording the picture manually

B Basic manual recording

This function is to setup the recording parameters of
recording setting pattern A to start recording manually. Ensure
all the cameras are connected and time and date has been
set correctly. Before you start recording, check the repeat
recording settings in the <Data Management Setting for Main
Memory> (System Menu - Memory) first, and then make the
recording settings.

@ Make the manual recording settings on the <Set
Recording Pattern A (Normal/Timer)>.

@ <Set Recording Pattern A (Normal/Timer)> can be used
for manual or timer recording. <Set Recording Pattern B
(Timer)> to <Set Recording Pattern D (Timer)> are used
for timer recording only.

@ Settings here are for manual recording only. For timer
recording, settings must be made on the <Timer> menu.

Setup Menu

1

Recording

—| 1 | Set Recording Pattern A (Normal/Timer) |

—| 1 |Camera Check

—| 2+D | Recording Setting A-Normal(Auto) |

L{ D | Recording Setting A-Normal |

—| 2+D | Recording Setting A-Normal(Easy) |

L{ D | Recording Setting A-Normal |

—| 2+D |Recording Setting A-Normal(Manual) |

D | Recording Setting A-Normal |

¢ Setting the recording rate and picture grade for
normal recording

step]. Execute camera check.

* The unit automatically detects the cameras
with video signal at their input when you select
“Execute.” The detected cameras are used in
the Auto and Easy settings calculation in step 2.

© After executing the camera check, the recording settings
are made only for the camera numbers with the video
signal input when using auto or easy setting.

step2, Set the normal recording menu.

Auto: Automatically sets the picture grade and

the recording rate by setting the recording cycle

and the recording hour per day. Set the desired

settings and then select “Execute.”

* The preview screen appears automatically when
the auto setting is executed.

Easy: Sets the frame or field recording, recording

rate, and picture grade for normal recording to

the same settings for all the cameras. When the

recording rate is set to “— — - for all the camera

numbers, normal recording does not perform. Set

the desired settings and then select “Execute.”

» The preview screen appears automatically when
the easy setting is executed.

Manual: Sets per camera, the frame or field

recording, recording rate, and picture grade for

normal recording. When you set “— — - for the

recording rate, the recording does not perform for

that camera number.

+ Select “View” to display the preview screen and
check your settings.

© When you set frame recording, the recording rate display
in the preview screen turns green.

© The recording rate display turns red when the value
exceeds 240 pps in total.

<Estimated Recording Time>

» The estimated continuous recordable time is displayed
on the bottom of the preview screen which is dependent
on the picture grade and the recording rate settings
for normal recording. (The time does not reflect alarm
recording settings.)

* When the main device is partitioned, <Estimated
Recording Time> shows the estimated recordable time for
normal recording.

step3. Press the REC/STOP button.
* The REC/STOP button lights up and recording
starts.

stepd, To stop recording, press the REC/STOP button for
more than 2 seconds.
» Recording stops and the light turns off.

REC/STOP

Basic operations
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Playing back the recorded data

H Basic playback

This function is used to playback recorded data. This unit
allows recorded data to be played back using various
methods. The basic playback described below is the most
common method for playback.

Press the PLAY button inside of the front door.
» Playback starts.
 After turning the power on, the oldest recording
data is played back first. Otherwise, playback
resumes at the stopped position of the previous
playback spot.
STOP PAUSE REV.PLAY PLAY

| ]| < >

JUMPTOEND = SPEED +

© When the “Playback Device Repeat Setting” is set to
“Repeat Off,” playback stops when reaching the physical
end of the HDD or end point of the recording section.
When the “Playback Device Repeat Setting” is set to
“Repeat On,” recorded data is played back repeatedly.
(System Menu - Memory - Recording Data Readout
Setting)

stepq.

[To change the playback device:]
step2.1, Select the playback device and playback area in the
<Select Source Device>. (User Menu - Search)
Main: Plays back the contents from the main HDD
device.
Normal: Normal recording area
Alarm: Alarm recording area
LPA: Long pre-alarm recording area
Copy 1: Plays back the recorded contents of the
copy 1 device.
“SerialBus,” “DVD/CD,” “USBmemory”
Copy 2: Plays back the recorded contents of the
copy 2 device.
“Internal,” “SerialBus,” “DVD/CD”

© “Alarm” appears when “Alarm Recording Area” is set
to other than “0 %.” (System Menu - Memory - Data
Management Setting for Main Memory)

© “LPA” appears when “Long Pre-Alarm Area” is set to

other than “0 %.” (System Menu -~ Memory > Data
Management Setting for Main Memory)

step2.2. Press the PLAY button.
» Playback of the selected device starts.
C) When you press the PAUSE/JUMP TO END button during

the playback is stopped, the still frame playback picture
around the end point of the latest recording is displayed.

step3. To pause playback, press the PAUSE button.
» To resume playback, press the PAUSE button
again or press the PLAY button.

step4. To stop playback, press the STOP button.

* When executing playback again, the playback
starts from the stopped position of the previous
playback.

© Pressing the OUTPUT A/B button on the front panel
switches the multiplexer video output. When OUTPUT Ais
selected, the button light indicator is off. When OUTPUT
B is selected, the button light indicator is on, and the
buttons related to playback function are operated for the
monitor screen connected to the OUTPUT B connector.
Pressing the OUTPUT A/B button again switches the
multiplexer output to OUTPUT A.

© The playback of each camera may not be executed at a
constant speed depending on the recorded condition.

O During the split screen display, the playback speed may
be slower than the speed used for recording.

© When playing back on both OUTPUT A and B, the
playback speed may be affected and become slower.




Searching the desired picture

Bl Basic search

This function is used to search the start point of needed
picture. This unit is equipped with 5 search functions (Search
by Time and Date, Search by Alarm List, Find data storage
location, Search by Book Mark, and Search by Motion). In
this section, the common search methods, search by time
and date and search by alarm list, are described.

4 Search by Time and Date

This item is used to search recording picture by specifying
date, hour, minute, second, and camera number. The search
result is displayed in still frame playback. When searching
for 1 camera number, the search result is displayed in the
single screen display. When searching for 2 or more camera
numbers, it is displayed in SPLIT16 screen.

User Menu

2 | Search by Time and Date

step], Select “Camera Filter” and select the camera or
cameras for the search function.

step2, Select “Search Select,” “Manual”’ and then set the
month, date, year, hour, minute, and second.
» To input the start and end points of recording,
select “Start” and “End” respectively.

step3. Select “Search” to activate the search function.

step4. To playback the searched picture, press either the
PLAY button or the PAUSE button.

step5.  To stop playback or still frame playback, press the
STOP button.

0 To change the source device to be searched, set the
desired device in the <Select Source Device>. (User
Menu - Search)

@ To display the single screen display of the desired
camera number when the search result is displayed in
the SPLIT16 screen, press the desired camera number
button.

O When there is no recording data of the set time, the
picture of the closest time and date for the set camera
number is displayed in still frame.

© When the multiple recording data of the same date and
time are existed, execute search by time and date more
than once until the desired picture is searched.

© Depending on the recording condition, search by time and
date function may not operate correctly.

© When you change the display from single to split or from
split to single during still frame playback, the recording
picture may not be existed at that point or picture may not
be displayed depending on the selected camera number
or timing of displaying the still frame playback picture.

Basic operations
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Searching the desired picture (continued)

¢ Search by Alarm List

This unit stores the start time of alarm recording and
emergency recording in the alarm list when such recording
begins. This item is used to search the desired picture using
the list of alarm recording (emergency recording). The search
result displays in still frame playback of the single screen
display.

User Menu

Search

m
3 | Search by Alarm List i

step 3
D |Alarm List r

Select “Sensor Filter” and select needed sensor.

stepq,

step2. Select “Time Date” and input the month, date, year,
hour, minute, second to be searched. Select “Alarm
List” to display Alarm List.

Latest: Displays the date and time of the latest

recording.

© The alarm list may take longer time to display completely
when there are many items in the list.

C) The displayed alarm list shows the list of alarm recordings
which have been started before and closest to the
specified time.

step3. Select the alarm list you want to display.

(1 o) change the source device to be searched, set the de-
sired device in the <Select Source Device>. (User Menu
- Search)

To execute alarm list search while the “Alarm area” and
“LPA area” are set, set the playback area to “Alarm” and
“LPA” respectively.

@ “Sensor” display indicates the sensor number to which
the alarm signal is input.

© When repeat recording setting for normal and alarm areas
are set to “Repeat Off’ and there is an alarm recording
(emergency recording) at the end of the HDD, that
recording may not be stored in the alarm list and that item
may be missed.

@ When the data of the camera number which is not
corresponded to the alarm sensor number is copied to the
external media, the alarm list of that data is not exactly
similar to that of listed in the digital recorder.

© When the detection of the motion or the ground of the
ALARM IN terminal occurs numerously at the same time,
not all the start times of the alarm recording may be
registered in the alarm list. In this case, the sensor of the
lowest number is registered in the list.

C) In the alarm list, items with the ALARM IN terminal
grounded are indicated in orange, items that were
detected with motion are indicated in white, items with
the EMERGENCY terminal grounded are indicated in
magenta, and items that were input with alarm signal via
communication are indicated in green.

O To clear the alarm list, erase the HDD data of which the

alarm recording is recorded (System Menu - Data Clear).
Beware that executing it erases all the data of the HDD
containing the picture data.

O Alarm list search is not performed if there are no index
signals.

© When alarm recording (emergency recording) is started
while displaying the <Alarm List>, you must first exit the
<Alarm List> and then display it again. The new item is
added to the list. In this case, you may have to specify the
date and time to be searched again.

© For alarm list search of LPA area, the list from the start

point of media is displayed when selecting “To latest,”
and the list from the end point of media is displayed when
selecting “ To oldest.”




Copying the recorded data

This item is used to copy the data to a copy device.

Hl Copy Data to Copy 1 Drive/Set Copy 1 Drive

This item is used to copy the data to Copy 1 device by speci-
fying the start and end points. The points are specified by
the date and time or the bookmark. This function is useful for
copying the data of the short period of time.

@ Before executing the copy, make sure that the Copy 1
device is connected and set in the <Add/Remove HDD
Device> and <Add/Remove DVD/CD Drive> correctly.
(System Menu -~ Memory)

User Menu

steps 4, 5

— 1 [ Copy Data to Copy 1 Drive

1+ 2| Range of Copy

steps 1, 2

LR

—| 3 |Set Copy 1 Drive

step]. Set the camera number to be copied.

* The button function changes between “All Off”
and “All On” each time you select this button.
You can switch on and off for all the cameras
easily by using this button.

e The picture is not copied when there is no
recorded picture of the set camera number or
time. Make sure to check that the picture of the
specified camera has been recorded on the
specified copy start point.

step2. Select “Other settings” and then set the detailed
settings.
From Device: Sets the device which contains the
data to be copied. The available setting items are
“Main” and “Copy 2.”
From Group: Sets the group which contains the
data to be copied. The available setting items are
“Normal,” “Alarm,” and “LPA” for main, “SerialBus,”
“DVD/CD,” and “Internal” for copy 2.
To Copy 1: Sets the group to where the data is
copied. The available setting items are “SerialBus,”
“DVD/CD,” and “USBmemory.”
Copy Data: Sets the data area to be copied. The
available setting items are “Alarm” and “All.”
Overwrite: Selects whether or not to overwrite the
existed data.
Auto Eject: Selects whether to eject media (CD/
DVD) automatically when the copy is over.

© “Alarm” appears for “From Group” when “Alarm Recording
Area” is set to other than “0 %.” (System Menu -~ Memory
- Data Management Setting for Main Memory)

O “LpA” appears for “From Group” when “Long Pre-Alarm
Area” is set to other than “0 %.” (System Menu -~ Memory
- Data Management Setting for Main Memory)

(1) During copy 2 operation, data cannot be copied from copy

2 device to copy 1 device. Stop copy 2 operation first and
then copy the data to copy 1 device.

@ When copying the data to DVD while “Overwrite” is set to
“On,” the unit clears the existing data on the disc before
overwriting with new data. Note that clearing the data
takes about 30 to 40 minutes. You cannot cancel opera-
tion during clearing the data of the DVD.

@© When copying the data while “Copy Data” is set to “Alarm,”
the unit performs copy operation, however, the data is not
copied if there is no alarm recording data within the speci-
fied range of copy. In case of CD/DVD disc, the remaining
capacity becomes low because only the management
information is recorded. It is recommended to carry out
“Calculate” in <Copy Data to Copy 1 Drive> to confirm
whether or not there is alarm recording data in the speci-
fied range.

step3. Select <Copy Data to Copy 1 Drive> and select “Start,”
“Start/End,” or “End” and then select “Set.” Input the
start/end time or select the bookmark of copy.
Start: Sets only the start point of copy. The data
is copied from the specified start point as much
data as possible with the remaining capacity of the
media to be copied.
Start/End: Sets the start and end points of copy.
When the amount of data to be copied is larger
than the capacity of a single CD/DVD disc, copy
all the desired data to multiple CD/DVD discs
according to the direction from the recorder. In
the case of copying to a USB memory or HDD,
only the amount of data equal to the available free
space on the copy destination media is copied. It
is recommended to check whether all the desired
data have been copied properly after the copy is
finished.
End: Sets only the end point of copy. The data
is copied as much data as possible with the
remaining capacity of the media to be copied until
the specified end point reaches.
» To set the bookmark point, select “Bookmark”
and then select the desired bookmark number.
* To copy from the oldest recording time, select
“Copy Start Time.” To copy to the latest
recording time, select “Copy End Time.”

stepd, Select “Calculate” to calculate the capacity of data
to be copied.

© When using “End,” the copy cannot be executed unless
the calculation of the capacity of data to be copied is com-
pleted.

@ When using “Start” or “Start/End” and executing copy
without calculating the capacity of data to be copied, the
progress or the time of the copy may not be displayed
correctly because the unit cannot determine the capacity
of data to be copied.

@ In the case of copying to a USB memory or HDD, when
the amount of data to be copied is larger than the availa-
ble free space on the copy destination media, the estimat-
ed copy data volume indicates the remaining capacity of
the copy destination media. It is recommended to check
whether all the desired data have been copied properly
after the copy is finished.

step5.  Select “Execute.”
» The copy starts.
» To stop copy manually, select “Cancel” in the
progress screen. The data which has been
copied before cancelling is copied.

Basic operations
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Copying the recorded data (continued)

B Copy Data to Copy 2 Drive/Set Copy 2 Drive

Copy 2 is a backup or archive feature. This item is used to
copy the data to Copy 2 device by specifying only the start
point. The point is specified by the date and time or the book-
mark. The copy continues until the end point of the recording
data reaches or the media to be copied becomes full unless
the copy is stopped manually (when “FIFO Overwrite” is set
to “Off”). This function is useful for making backup of the re-
cording data.

© Before executing the copy, make sure that the Copy 2
device is connected and set in the <Add/Remove HDD
Device> and <Add/Remove DVD/CD Drive> correctly.
(System Menu - Memory)

—| 2 | Copy Data to Copy 2 Drive

1+ 2| Range of Copy

steps 1, 2

AR

—| 4 |Set Copy 2 Drive

step]. Set the camera number to be copied.

* The button function changes between “All Off’
and “All On” each time you select this button.
You can switch on and off for all the cameras
easily by using this button.

* The picture is not copied when there is no
recorded picture of the set camera number or
time.

step2, Select “Other settings” and then set the detailed

settings.

From Main: Sets the area which contains the
data to be copied. The available setting items are
“Normal,” “Alarm,” and “LPA.”

To Copy 2: Sets the group to where the data is
copied. The available setting items are “SerialBus,”
“DVD/CD,” and “Internal.”

Copy Data: Sets the data area to be copied. The
available setting items are “Alarm” and “All.”
Overwrite: Selects whether or not to overwrite the
existed data.

Auto Eject: Selects whether to eject media (CD/
DVD) automatically when the copy is over.

FIFO Overwrite: Selects whether to repeat
copying from the start point of the media by
overwriting the existed data, or to stop copying
when the capacity of the media becomes full
during copying. This setting is available only when
the copy destination is HDD.

© “Alarm” appears for “From Main” when “Alarm Recording
Area” is set to other than “0 %.” (System Menu -~ Memory
- Data Management Setting for Main Memory)

@© “LPA” appears for “From Main” when “Long Pre-Alarm

Area” is set to other than “0 %.” (System Menu -~ Memory
- Data Management Setting for Main Memory)

@ When copying the data to DVD while “Overwrite” is set
to “On,” the unit clears the existed data of the disc before
overwriting with new data. Note that clearing the data
takes about 30 to 40 minutes. You cannot cancel opera-
tion during clearing the data of the DVD.

@© When copying the data while “Copy Data” is set to “Alarm,”
the unit performs copy operation, however, the data is not
copied if there is no alarm recording data within the speci-
fied range of copy. In case of CD/DVD disc, the remaining
capacity becomes low because only the management
information is recorded.

@ Do not use the disc which has been used on the personal
computer, failed to be copied, or stopped during copying

due to the power failure because they may cause mal-
function of the unit.

step3. Select <Copy Data to Copy 2 Drive> and select “Start”
or “Continue” and then select “Set.” Input the start
time or select the bookmark of copy.

Start: Sets the start point of copy.

Continue: Starts copying from the end point of the

previous copy.

* To set the start point using the bookmark,
select “Bookmark” and then select the desired
bookmark number.

» To copy from the oldest recording time, select
“Copy Start Time.”

step4, Select “Execute.”

* The copy starts.

» To stop copy manually, select “Cancel” in the
screen of <Copy Data to Copy 2 Drive>. The
data which has been copied before cancelling is
copied.

@ The warning is displayed when the copied range exceeds
the available capacity of the device to be copied when
“FIFO Overwrite” is set to “Off” and the copy destination
is HDD. In this case, set the copy setting again with nar-
rower copy range or use a copy device with larger capac-
ity.

@ When the copy is performed during recording, the picture
of the recording start and end points may not be record-
ed.

@ When the recording data of the main device which is be-
ing copied is about to be overwritten or has been over-

written, copy is stopped. Be careful for the copy which
requires long time such as overwriting copy of DVD.

© The progress bar of copy is not displayed for copy 2.

C) The picture data is processed in 2 MB unit. Therefore the

data is copied in 2 MB unit from the start point of the des-
ignated range when copying.




H Copying the data of this unit to a video
cassette

This function is used to copy the data of this unit to a video
cassette using an analogue video cassette recorder. Data
can be copied even when the unit is in recording. For the
recording operation, see the instruction manual for the ana-
logue video cassette recorder used.

stepq,

step2,

step3,

step4,
step5,

step®.

[Analogue video cassette recorder] Prepare the

VCR for recording.

» Set the input source of the VCR to the external
input.

[This unit] Display the picture in its format (single/
split) that you want to record.

[This unit] If needed, use the search function to
display the start position of copy.

[Analogue video cassette recorder] Start recording.
[This unit] Press the PLAY button to start playback.

To stop copying, press the STOP button on this unit
first. And then, stop the recording on the analogue
video cassette recorder.

@ Only the picture displayed on the monitor screen can be
copied to the video cassette.

Basic operations
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Copying the recorded data (continued)

B Playback software

When copying the data to CD/DVD or USB memory, the
needed PC playback software is automatically copied on to
the disc. Refer to the following for using the software.

4 System requirements

¢ 0OS: Microsoft Windows 2000 or Windows XP.

*  CPU: IBM PC/AT compatible with an Intel Pentium series
processor of at least 500 MHz.

*  RAM: 256 MB or more.
» HDD: System drive with unused space of at least 200 MB.
» Display device: XGA (1024 pixels x 768 pixels) or higher.

¢ Starting up the application software

step]. Load the CD/DVD/USB memory which has been
used for copy to the personal computer.
step2. Double-click the icon of the disc to open.
[C)D_REC
caon
BB lerlieexe
step3. Start up the application software.

* Double-click the “FSM Player Lite.exe.” The
application software starts up and the operation
panel appears.

When the picture cannot be loaded, use the
[Folder] command in the [File] menu to select
the picture folder to be played back.

© You can open the FSMPlayerLite panel in 4 stages by
clicking = on the right side. In the first stage, you can
select playback, search and bookmark operations. In the
second stage, you can select a camera to display. In the
third stage, you can adjust playback speed (reducing
only) and in the fourth stage, you can make various set-
tings for audio playback.

FiodF) Sewchi) Operaton(O) Dooknart(E) Veew(¥) Groupnal®) Menu
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Caierr ) Operational
Retresh Speed
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s
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1h v @ NeEmen. Shen [} Lang
Playback
) Emcsan,

4@ Operational panel

W Rewind

Click to jump to the head of the recording data.

Reverse Search

Click to playback the picture in the reverse direction with
a higher speed than normal playback. The speed changes
from X1 to X2, X4, X8 and back to X1 at every press of
this button during reverse playback.

Reverse Playback

Click to playback the picture in the reverse direction.

m Field Reverse
Click to display a still picture one field before.

Stop

Click to stop playback. Audio, if recorded, is played back
after the stop when [Not Synchro.] is selected and the
audio command has been enabled.

E Field Advance

Click to display a still picture one field after.

Playback

Click to playback the picture in the forward direction.

i Forward Search

Click to playback the picture in the forward direction with
a higher speed than normal playback. The speed changes
from X1 to X2, X4, X8 and back to X1 at every press of
this button during playback.

to Camera

(These buttons are displayed when the = button
located on the lower right of the Forward Search button
is pressed.) Click to display the picture of the camera
corresponding to the number of the button. The indicator
turns green for the camera number which is being
displayed, and it turns black for the camera number which
is not being displayed. The picture is not displayed even
when the indicator turns green if the data has not been
copied for that camera number.

Refresh Speed

(This slider is displayed when the =3 button located on the
lower right of the Camera button is pressed.) Drag with
the mouse to adjust the playback speed. When setting
to [Fast], it may disrupt the operation depending on the
performance of the personal computer used. Use this
setting with the proper picture playback speed suitable to
the personal computer used.

The playback speed slider may not be changed at a
constant interval when the data which is additionally
copied is played back.

Output
(This is displayed when the =i button located on the
lower right of the Refresh Speed slider is pressed.)
[Not Synchronized playback]
Put a checkmark to [Output] on the FSMPlayerLite panel
and select a playback channel from the drop-down menu.
Then select [Not Synchro.] in the [Playback] field. Play
back the copied data and stop at a point where you want
to hear the audio. The audio data around the stop point
are played back. You can change the duration of audio
playback in 3 levels using the slide bar on the right side.
The actual duration of audio playback varies depending
on the frame rate of the recorded picture. Adjust the
duration for every data to be played back.
[Synchronized playback]
Select [Synchro.] in the [Playback] field. You can play
back simultaneously the audio and picture of the data
downloaded in blocks via network or the data copied
together with audio by a recorder. Only one playback
channel is displayed in this case. Audio is not played back
during other than normal playback (such as fast-forward
playback and reverse playback). The [LipSync] slide bar
should be adjusted according to the PC to be used and
the recording status of data to be played back. In some
cases, there may not be found an optimum position where
the picture and audio synchronize with each other.




@ In synchronized audio playback, the frequency of picture
refreshing is reduced depending on the processing power
of PC. When you want to playback giving priority to
picture, select [Not Synchro.].

O The settings on this panel remain intact for the next start-
up.

@ Audio playback channel and picture display channel are
not related.

@ When data are played directly from a drive that is slow
to read CD and DVD, audio may be output intermittently.
For better results, copy to PC HDD then playback from
PC.

4 File menu

Convert

Selectable after playback is stopped, [Convert] screen
appears. Specify the range to be converted and the cam-
era number, and then press the [JPEG] or [AVI] button to
convert and save the picture data collectively. Collective
conversion requires adequate free space in the physical
memory and the HDD for temporary files (the system par-
tition and save drive). The limitations of available memory
space and HDD space vary depending on your operating
conditions.

Perform conversion starting from a small file that requires
only several seconds to be converted while checking the
state of the memory and the HDD.

4 Search menu

Search

When selected, the [Time Search] screen appears. Spec-
ify the date and time to be searched, and then click the
[Search] button.

The picture of the specified time or around such time
appears. The search may not be performed when the
date and time information of the recorded contents is not
chronological such as the data which is added to the ex-
isting data.

4 Operation menu

For [Playback], [Stop], [Reverse Playback], [Forward Search],
[Reverse Search], [Field Advance], [Field Reverse], or [Re-
wind], refer to the section of the “Operation panel.”

4 Bookmark menu

A-, B-
Select to register the current playback position as Point A
or Point B to repeat playback between those positions.

Repeat between A and B
Put a check mark to repeat playback between Point A and
Point B.

¢ View menu

Picture Size
When selected, the options of [100%], [75%], [50%], and
[25%] appear. Pictures are zoomed in or out according to
the selected magnification.

Decode Level
When selected, the options of [Fine], [Middle], and [Rough]
appear. When setting the decode level to rough, the pic-
ture becomes rough and the playback update speed be-
comes faster.

Title Bar
When selected, the options of [Date Time] and [Alarm]
appear. Put a check mark to the item to be displayed on
the screen.

4 Grouping menu

Grouping Pattern
When selected, the [Grouping Pattern] screen appears.
When you click the [4 Multi], [6 Multi], [9 Multi], [10 Multi],
[13 Multi], or [16 Multi], the split screen of the selected
pattern appears. Click “Setting” to display the screen to
set the display position of the camera in each screen.

4 Menus appearing with right button clicking

© To use the following functions, click the right button of the

mouse on the screen to be operated. The following func-
tions are performed only for the clicked screen.

During playback:
Picture Size

Refer to the section of the “View menu.”

Decode Level
Refer to the section of the “View menu.”

During stopping playback:

Copy
Select to copy the picture being displayed onto the clip-
board.

Save As
When selected, the [Save As] screen appears. You can
save the picture being displayed as either a Windows bit-
map file (.bmp) or a JPEG file (.jpg).

Picture Size
Refer to the section of the “View menu.”

Decode Level
Refer to the section of the “View menu.”

Print
When selected, the [Print] screen appears.
After setting the [Margins], [Printer Settings...] and other
options, click [Print] button to print the picture being dis-
played.

@ When playing the data recorded in frame recording, the
outline of the picture may be serrated. In such case,
change the picture size to larger setting.

© When loading the media with a lot of picture data copied,
playback software may take time to be started up.

Basic operations
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Communications by Web Browser

B Communications by Web Browser

The Web browser on the personal computer can display the
live video and the pictures that have been recorded from the
camera that is connected to this recorder. Also, some of the
recorder settings can be made via the personal computer.

@ The personal computer product requirements
¢ OS: Microsoft Windows 98SE, Windows 2000,
Windows Me or Windows XP.
¢ CPU: IBM PC/AT compatible with an Intel Pentium series
processor of at least 500 MHz.
«  RAM: 256 MB or more.
» HDD: System drive with unused space of at least 200 MB.
» Web Browser Soft: Microsoft Internet Explorer 5.5 or later.
» Display device: XGA (1024 pixels x 768 pixels) or higher.
@ Microsoft and Windows are registered trademarks of the
Microsoft Corporation in the US and other regions.
(The official name of Windows is Microsoft Windows
Operating System.)
All other company and product names appearing herein
are the property of their respective owners.

* Windows 98SE is an abbreviation of Microsoft
Windows 98 Second Edition.

* Windows 2000 is an abbreviation of Microsoft
Windows 2000 Professional.

* Windows Me is an abbreviation of Microsoft
Windows Millennium Edition.

* Windows XP is an abbreviation of Microsoft
Windows XP Home Edition/Professional.

@ The product requirement described above cannot
guarantee operations in all environments.

@ Lack of compatibility between Web functions and the PC
peripheral driver may, in rare instances, result in abnormal
operation. If this happens, upgrade to the newest version
of Internet Explorer and try again.

4 Connections

* When making a direct connection between this unit and
a personal computer (hereinafter PC), use a cross cable,
and when making a connection through a HUB, use a
straight cable.

* Refer to the PC instruction manual for instructions on how
to set the Web settings on the PC.

M Login
Start up the Microsoft Internet Explorer and log in.

step]. Start up the Microsoft Internet Explorer and enter
the IP address of the recorder.

* Enter the IP address which is set in <LAN
(Communication) Setting> (System Menu -
COM/LAN). When shipped from the factory, the
IP address is set to “192.168.000.100.”

» The “[Login]” screen appears.

Login]

¢ mirsusisi
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step2.1. (When loggingin e« «)

First, enter the “User ID” and the “Password.”
When shipped from the factory, the user ID for
the full-rights user is “root,” and the password is
“admin000,” the user ID for the live user is “guest”
and the password is “guest.”

@ More than one user can log in simultaneously using the
same user ID and password.

@ However, there are restrictions depending on authoriza-
tion. The maximum number of users that can be connect-
ed at the same time is 10.

step2.2. Select “login” and then left-click or press ENTER.
* The “[Main Menu]” screen appears.

ox-TL4516 Login:root

[Main Menu]
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step3.1. (If you make an error in entering the user ID or
password ¢ ¢ ¢ )
» The “[Caution]” screen appears.

step3-2. Select “Login” and either left-click or press ENTER.
» The “[Login]” screen appears.

step3.3. Follow step 2-1 and enter the correct “User ID” and
“Password.”

ster4.1, (If you do notlogine-=)

Select “If you won't log in, please go to Logout.” and
left-click.

step42. The message “Session ID removed from recorder
& browser. Please close the browser.” is displayed.
Close the Web Browser at this point.

step5.1, (To change password ¢ « )

The password can be changed in the “[Login]”
screen only by the user who has the authorization
to change a password. Follow the instructions
in the menu and enter the current “User ID” and
“Password.”

step5.2. Enter the new password in “New password” and
again in “New password (Confirmation).”

@© The number of characters that can be used in registering
a password is 16. Both alphabet letters and numbers can
be used with a distinction made between upper and lower
case. You cannot use spaces.

step5.3. To change to a new password, select “change” and
left-click or press ENTER. To cancel the change,
select “clear” and left-click or press ENTER.

B Main Menu

This is the screen for selecting, from “Main Menu,” “Live
Monitoring” with which live pictures are retrieved and
displayed, “Playback” with which pictures that have already
been recorded are retrieved and displayed, “Configuration
Menu” which allows changes to the settings of the recorder,
“Logout” for ending a job, or “Change Login User” for making
a change in the logged-in user.

@ Depending on the user’s authorization, there are certain
menus that cannot be selected.

@ The transfer rate at communication changes depending
on the communication environment or unit’s status. For
stable communication, use this unit with the proper image
transfer speed suitable to the conditions of the communi-
cation line.

@ The user’s session ID (connection data) is lost in 5 min-
utes from the final operation that includes picture retrieval.
If no operations are made within that 5 minutes, no other
operations can be made after that so close the browser
and then log in again.

@ If the unit's MAIN switch is “OFF,” live and recorded pic-
tures cannot be retrieved.

step]. Select the desired menu from “Main Menu” and left-
click.

ox-TL4516 Login:roo

[Main Menu]
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Communications by Web Browser (continued)

4 Live Monitoring
Displays live video on the PC screen.

step]. Select “Live Monitoring” and left-click.
« The “[Live]” screen appears.

@ When video retrieval via web browser is tried for the first
time, a message as shown below may be displayed. If it
is displayed, click “Yes.”

Security Warning

Do you want to install and run "DXY50_0CX" signed on
24/02/2004 15:29 and distributed by:

Mitsubishi Electric Corporati

Publisher authenticity verified by VeriSign Class 3 Code
Signing 2001-4 C&

Caution: Mitsubishi Electric Corporation asserts that this
content is safe. You should only install/view this content if
you trust Mitsubishi Electric Corporation to make that
assertion.

B

[ Always trust content from Mitsubishi Electric
Corporation

[ Yes ] E No

i Qore Info ]

@ When the unit is recording at the full rate (240 pps), the
picture supplied from the camera which is not used for
recording at that time may not be updated.

Login:roo
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<Function description>

STOP . Stops the retrieval of an picture.

GO . Starts (or restarts) the retrieval of an pic-
ture.

Display For selecting either the display or non-
display of a camera number.

Layout For selecting from the 12 types of display
patterns.
(default: 4(1-4) screen)

Camera . Selects the camera number that you want

to display and check.

Transfer Rate : Selects one of 5 stages from “Lo” to “Hi”
for picture retrieval speed.

(default: middle)

Save Layout : The layout of the screen display is regis-

tered to “Local PC.”

Main Menu . Returns to the “Main Menu.”

Logout For logging out.

@ Setting “Transfer Rate” to “Hi” may present a problem
to the PC operations. This could be due to the PC’s
hardware/software performance you are using. Adjust the
image transfer rate that best meets your machine.

(1) Depending on the network capacity and the load
conditions, the transfer rate may be affected.

@ Picture may vibrate vertically when displaying the live
picture of the camera of which picture is set for frame
recording.




4 Playback

Retrieves, plays back and searches for pictures that have
been recorded by the recorder.

step].  Select “Playback” and left-click.
» The “[Playback]” screen appears.

Login:roof
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step2, Press the » button.
» Playback starts.

<Function description>

> : Press to start playback.

» : Press to start speed search in the forward direc-
tion at speeds of x2, x4, x8 and x16.

M : Press to frame-by-frame playback in the forward
direction.

4 : Press to start reverse playback.

: Press to start speed searches in the reverse direc-
tion at speeds of x2, x4, x8 and x16.

4 : Press to frame-by-frame playback in the reverse
direction.
| : During playback or searching, press to stop play-

back for still frame.

Device : Selects the HDD for playback and search.

(default: Normal)

Q The date, time, and the camera number for the picture ac-

quired are displayed in “Image Information.” Clicking “Save
Image” stores the picture that is still-frame displayed in
the PC in bit map format.

Q The following searches can be selected in single-screen
display.

Jox-TL4s1G Login:roof

[Playback]
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@ The function of searching for recorded picture data is
effective only when the single-screen display has been
selected in the “Playback” menu. The function cannot op-
erate during picture data playback so to make a search of
any type first stop the playback.

@® Time Search

Select the date and time and click “Search.”

Communications by Web Browser
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Communications by Web Browser (continued)

@® Alarm List Search

Click “Alarm List” and the “Alarm List Search” screen appears
in the sub-screen.

i,_ Alarm List Search — Normal

Alarm List

2004/10/06 ¥ 18:47:26 j

Prev1000

Next1000

1 5 10 11 14 15 16
ivEvE-EvB-Ev-EvE-BvR-EvEvEvEvR-gv]

Alarm Type

2007/111813:38:43
202210114 14:34:28
2010/07/21 18:45:20
2007111/1813:39:02
2023111i27 10:28:51
2023/12i08 19:49:53
2023/05/18 00:38:13
2030/10i23 12:37:07
2023M2i0815:07:29

NNAINDIIN 10.01.92

step]. Set the desired date/time and number of alarm list

items to be acquired, and then click “Refresh” to

acquire the alarm list.

* The alarm list cannot be acquired without
clicking “Refresh.”

« Enter the needed number of alarm list items to
be acquired in “Alarm Cnt.” If number entered is
too large, depending on the recording condition,
it may take a long time to acquire the list or
the desired number of list items may not be
acquired.

» “Sensor”: Check the desired sensor number for
acquiring the alarm list items.

step2, Select the “No.” desired, and then click “Search.”
» Click “Prev(number)” for a search in the reverse
direction and click “Next(number)” for a search
in the forward direction.
» Click “Refresh” again to re-acquire the “Alarm
List,” and click “Close” to hide the “Alarm List
Search” menu.

step3. When the image of the alarm is displayed, close the
search screen and press P to review the alarm.

@® Image Search
Click a to display the picture of the next alarm list item.

Click w to display the picture of the previous alarm list item.

¢ Configuration Menu
This is the screen for making some of the recorder settings.

step]. Select “Configuration Menu” in the “[Main Menu]’
screen.
» The “[Configuration Menu]” screen appears.

Jox-TL4S16 Login:roof
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[Configuration Menu]

step2. Select the desired “Configuration Menu” and left-
click.




@ User Registration

This is the screen for changing the settings for registered
user authorization, and for deleting a registration. It can also
be used for registering new users.

step]. Select “User Registration” and left-click.
» The “[User Registration]” screen appears.

Login:root
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step2.1. (To change registered user settings ¢« ¢ )

Select the user ID for changing the settings in the
“Change authorities of users” settings.
» Select the items that you want to change.

<Authority>

Live Monitoring : Allows viewing of live pictures. It is a

mandatory rank to be registered.

Playback : Allows viewing of recorded pictures.

All Cameras : Allows viewing of pictures from all the
cameras. (The picture of the cam-
eras set to “Off” in the covert camera

setting can also be displayed.)

Change Passwords : Allows changing of user’s password.

Configuration : Allows viewing and editing of user

registration information.

@ Certain items cannot be selected depending on what the
user authorization is.

© “Configuration” authorization can be used by only one
user. From the time that a user logs in until that user logs
out and gives up authorization, any other user that logs in
is regarded as a user who does not have “Configuration”
authority.

© ‘Playback” authorization can only be used by one user.
From the time that a user logs in until that user logs out

and gives up authorization, any other user that logs in is
regarded as a user who does not have “Playback” author-

ity.

step22. (To change settings ¢+ ¢ )

Select “change” and left-click. The “[Change
Confirmation]” screen appears.

step2.3. If you want to make the change, left-click “change.”
If you want to cancel a change, left-click “cancel.”

step2.4. (When you have selected “change” « ¢ ¢ )

The “[Completed]” screen appears, so then left-click
“User Registration.”
» The “[User Registration]” screen reappears.

step2.5. (When you have selected “cancel” ¢« ¢ )
» The “[User Registration]” screen reappears.

step3.1. (To delete a registered user e+« ¢ )

Left-click on “remove” in the user ID that you want
to delete in “Change authorities of users.”
* The “[Remove Confirmation]” screen appears.

step3.2. If you want to delete it, left-click “remove.” If you
don’t want to delete it, left-click “cancel.”

step3.3. (If you have selected “remove” ¢ « ¢ )

The “[Completed]” screen appears, so left-click “User
Registration.”
» The “[User Registration]” screen reappears.

step3.4. (If you have selected “cancel” « ¢ ¢ )
» The “[User Registration]” screen reappears.

step4-1. (To register a new user e« +)

Enter the new user ID and new password in “Add
New User.”

stepd2. Refer to step 2-1, select the “Authority” desired and
put a check mark.

@ A user ID with the same name cannot be registered. The
maximum number of characters that can be used in reg-
istering a password is 16. Both alphabet letters and num-
bers can be used with a distinction made between upper
and lower case. You cannot use spaces.

stepds. If you want to make a new registration, left-click
“register.” If you want to cancel a new registration,
left-click “clear.”

step4.4. (If you have selected “register” « « ¢ )
It is added to “Change authorities of users.”
step4.s. (If you have selected “clear” ¢+« )

Clears the specified contents.

Communications by Web Browser
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Communications by Web Browser (continued)

@® Recorder Title & Camera Titles

This is the screen for setting or changing the recorder and
the camera titles.

step], Select “Recorder Title & Camera Titles” and left-
click.
* The “[Recorder Title & Camera Titles]” screen
appears.

Lagin:roof
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step2. Enter the desired recorder or camera title to “New
Text.”
* The recorder and the camera titles currently set
are shown in the “Current Text.”

step3. Select “change” and left-click.
» Then new changes are displayed at the recorder
monitor A or B output. Also, the recorder “Camera
Display Mode” must be setup to display camera
titles.

@® E-mail Setup

This is the screen for setting the information related to the
e-mail server or sender, and for setting the e-mail address of
the receiver.

step].  Select “E-mail Setup” and left-click.
* The “[E-mail Setup]” screen appears.

Legin:roof

§ mirsusisi
4 W ELECTRIC

Nw Settings
SMITP Server (st Nare ar IF)
POP Server (Host Name a 1F)
POP Lser 1D
POP User Pusswurd
DS Server 1 Adtress
DN Server 2 Addowss
From;
Recorder 1D
Delay time fo atachment

Picture Remain TompFan Reboot Rocerd Alarm Seruor

ot o DN = W N X M 2 N
e o N = % Fl

" I < 4 s Ll
Receiverd o N = u ]
-« I = s = -

wort
Rerehers

=
]
'
-
ol

step2.  (When making the settings to send the e-mail ¢ « ¢)

Input the desired settings for “SMTP Server (Host

Name or IP),” “POP Server (Host Name or IP),”

“POP User ID,” “POP User Password,” “DNS Server

1 Address,” “DNS Server 2 Address,” “From:,” and

“Recorder ID.”

* The settings currently set are shown in the
“Current Settings.”

0 The maximum number of characters that can be used to
set the e-mail address is 49.

step3. To send the test e-mail, select “From Address Test
(send test mail)” and left-click.

stepd.  (When attaching alarm recording picture to e-mail «
L] l)

Put a check mark on “Picture” checkbox.

» E-mail with the picture which is captured during
alarm recording is sent to the marked user. The
file extension of the picture data file which is
attached to e-mail is “.aap”.

» “Delay time to attachment” is used to determine
the timing of capturing the picture to be
attached. The time period between occurrence
of alarm and capture of the picture can be set
up to 10 seconds.

@ You can send the picture when the alarm recording is
performed.

© A picture is sent via e-mail only when the alarm is
triggered by the recorder's rear termianl inputs. Alarm
recording set by motion does not send a picture by e-mail.

@ To perform this function, put a check mark on “Sensor.”

© When the multiple notifications are occurred at the same
time, notification may be delayed or not all the items may
be notified.

© When the alarm recording time is shorter than the
specified delay time, the picture cannot be attached.

© When the multiple alarm signals are input at the same
time, only the picture from the camera corresponding to
the lowest sensor number is attached.




C) To view the attached picture:

In the PC with supplied application software installed,
click or double click the file.

In the PC without supplied application software installed,
drag the file and drop it into the “MPicViewer.exe” which
is stored in the supplied CD.

© The displayed picture can be printed or can be saved in
general image formats.

step5.1. (When setting the receiver’s address ¢ ¢ ¢)
Enter the desired e-mail address to “New Address.”

step5.2. Set the contents to be transmitted from the recorder
to the PC.
* “Remain,” “Temp/Fan,” “Reboot,” “Record,”
“Alarm,” and “Sensor” settings can be set.

step5.3, Select whether to activate or inactivate the e-mail
address you have set.
* When a check mark is put to “Active” column,
the selected e-mail address becomes active.

step5.4, Select “set” and left-click.

step5.5, Select “send” to send the test e-mail.

@© When the e-mail notifications or IP notifications have
been occurred frequently, the operation of the recorder
may become unstable.

Communications by Web Browser
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Communications by Web Browser (continued)

@® Access Mode Setup @® Clock Setup
This is the screen for changing the SSL settings. This is the screen for setting the clock of the recorder via PC.
step]. Select the item to be changed in the “Access Mode  step1. Select “Clock Setup” and left-click.

Setup.” » The “[Clock Setup]” screen appears.

* Use SSL for Web Access: TS Togairoo

Sets the level of the encoding function (SSL). e R
“No SSL”: Does not use the encoding function.
“Menus only”: Uses the encoding function for the
menus only.
“Menus + Pictures”: Uses the encoding function
for the menus and pictures.
e SSL Port Settings:
Sets the port number used for SSL communication.
* Band-Width Limit:
Controls the band width of the communication.

Lugin:roof

¢ miTsueism
4 W ELECTRIC

Use S5L for Web Arcess

SSL Port Sevtings

T i o = step2.1, Set “Month,” “Date,” “Year,” “Hour,” “Min.,” “Sec.,”
“Time Zone” to the desired time.

step2.2, Select “set” and left-click.

step3. (When setting the clock using “Synchronize with
PC’s clock” ¢ « ¢)

When you want the clock of the recorder to be
synchronized with the PC clock, select “Synchronize
with PC’s clock” and left-click.
» The clock of the recorder is set to the same time

as that of the PC.

@ When you use SSL, the following message appears. Se- » When using this function on the timing that the
lect “Yes” and then continue the operation. year, month, day, hour, or minute is changed,
check the clock after synchronizing with the PC
Security Alert E| C|0Ck
@ ‘&%E;mrﬁm:“;bgmr“; stepd,  (When setting the daylight saving time function « ¢ )
@ T Select “No” when you do not want to use the

you wart to trust the certifying authority.

daylight saving time function.

& The security certificate has expired of is not yet valid.

Select “Auto” to use the daylight saving function.

The name on the secusity certificate is invalid or does not

melch the name o the stz * When selecting “Auto,” set the desired time
Dovey vond o bioceed? period for activating the daylight saving time
Yoo | [ Ho ] [ewCenticas ] function and then select “set.”

@© When displaying live or playback picture while “Use SSL
for Web Access” is set to “Menus only,” the following mes-
sage appears. Select “Yes” to display the live or playback
picture.

In this case, the key-shaped icon which shows the

encoded communication of the browser is not displayed,
however, communication is carried out with encoded.

Security Information

This page contains both secure and nonsecure
items.

Do you want to display the nonsecure items?

[C2e J[ Mo J[ Moeinio ]

step2. Set the desired setting in “New Settings” and then
select “change” and left-click.




4 Logout
In this screen, assign “Logout” settings to end the job.

step]. Select “Logout” and left-click.
» The “[Logout]” screen appears.

Loginzroo

¢ mirsusisHi
&7 W ELECTRIC

step2, Close the Web Browser.

@ If the browser is closed incorrectly (not logging out cor-
rectly), the user’s session ID is saved for 5 minutes. If the
Log in is made with the same user ID within that 5 min-
utes, operation limits may take effect.

4 Change Login User
This screen is for changing the logged in user.

step].  Select “Change Login User” and left-click.
» The “[Login]” screen appears.

Login]

¢ wmirsusisHi
&7 W ELECTRIC

step2.1. (To change the logged in user ¢« ¢ )

In the “Login (or change login user)” settings,

execute step 2-1 and 2-2 in “® Login” and change

the logged in user.

* The logged in user is changed and the “[Main
Menu]” screen appears.

step22. (To log in without changing the user + « ¢ )
Select “Return” button on the browser and left-click.
step23. (Tolog out e« e)

Select “If you won't log in, please go to Logout.” and
left-click.

Communications by Web Browser

33



34

Troubleshooting

If problems with the unit persist even after you've followed the suggestions below, disconnect the power cord and contact the
retailer from whom you purchased the unit.

Description of problem

Consult the following

The unit does not be turned

on.

* Is the power cord properly plugged in?

Is the LOCK indicator light on?

Is the TIMER indicator light on?

Is the MAIN switch on the rear of the unit set to “OFF” ?

Power is on, but the unit

Is the LOCK indicator light on?

% does not operate. * |Is the POWER indicator flashing? (The unit cannot be operated while the POWER
% indicator is flashing.)
E:' » The safety features may be in operation.
2 Reset the unit by pressing the RESET button on the rear panel using a ballpoint
pen or similar object, and then turn the power on again.
Pictures are not appearing » Are the monitor and camera(s) connected correctly?
on the monitor. * |s the unit receiving an input signal from the selected camera?
Check this by displaying the SPLIT16 screen.
The quality of the monitor * Is the connecting cord connected correctly?
picture is poor. * |s the camera’s focus adjusted correctly?
The unit does not start * Is repeat recording set to "Repeat Off"?
recording. » The recording starts after the time set for recording rate is passed.
Was the unit stopped during that time?
The unit does not stop * |s the LOCK indicator light on?
recording.  During normal recording, alarm recording, and emergency recording, press the
REC/STOP button for more than 2 seconds.
o * Is timer recording in progress?
% To stop timer recording, press the TIMER button for more than 2 seconds.
Do: The unit does not repeat the * Is repeat recording set to "Repeat On"?
@ recording.

The unit does not perform

timer recording.

Are the date and current time set accurately?

Are the recording start-/end-times and the recording rate set correctly?

Is repeat recording set to "Repeat Off"?

The unit does not perform

alarm recording.

Is the recording rate for alarm recording set to “— — —"?

Is the recordable capacity for alarm recording area full?

Is the unit in timer recording stand-by mode?
(Is the TIMER indicator light on?)

« Are the peripheral switches, etc., connected correctly?




Description of problem

Consult the following

The unit does not perform

playback.

* Is the LOCK indicator light on?

Has the data been erased?

Is the correct playback device selected?

PERIPHERAL RECORDING DEVICE |PLAYBACK

The copy device dose not

respond.

Has the recording medium been inserted correctly into the unit?

Is the unit currently in the middle of loading the recording medium?

Is the correct playback device selected?

Has the recording medium's write-protect been removed?

Is the power supply of peripheral recording device set ON?

Is the copy device registered in the <Add/Remove HDD Device> or
<Add/Remove DVD/CD Drive>?

OTHERS

The camera cannot be

controlled via this unit.

Is the camera to be controlled connected correctly?

Is the <PTZ Setting> menu set correctly?

The unit does not perform
the motion detection

function.

Is trigger for alarm recording of the camera number for which the motion

detection function to be executed set to “External” ?

Is the alarm recording rate of the camera number for which the motion detection

function is executed set to “— —-"?

Is the value set in “Motion Threshold” of the <Motion Det> menu larger than that
of “Motion Mask Settings” ?

Is the detection area set correctly?

The unit cannot be controlled

via the personal computer.

Is the <COM/LAN> menu set correctly ?

Are the unit and the personal computer connected correctly ?

Is there a defect in the connecting cable ?

Is the proper connecting cable being used ?

There is a camera number
with a blue screen during

split screen display.

The screen of camera number with no video signal input appears blue even when

setting for operation.

Button operation is not

working.

Is the POWER indicator flashing?
(The unit cannot be operated when the POWER indicator is flashing.)
Is the LOCK indicator light on?

Cameras cannot be
switched with the

camera number buttons.

Is the menu screen being displayed?

Camera number buttons cannot be used when the menu screen is displayed.

Menus cannot be set.

When OUTPUT B is selected, the cursor of the mouse is displayed, however, the
menu screen is not displayed and cannot be set. The menus can be set only
when the OUTPUT A is selected.

Following functions do not

work:

» Copy1

« Deletion of copy 1 device
data

* Loading/Saving menu

* Restore

* Picture copy

Is section download function (the function to copy the picture data remotely using
the supplied application software) performed via communication?
The functions described to the left are not performed while section download

function is in use.

Troubleshooting
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Warnings and CALL OUT output

Bl Warnings and their appropriate countermeasures

#1 Options in the CALL OUT output column:

» Selectable: Selects to output CALL OUT signal or not on the menu screen.
» Fixed: Outputs CALL OUT signal from the CALL OUT terminal regardless of the menu setting.
* None: Does not output CALL OUT signal, but displays a warning on the screen.

C) The warning display appears when the HELP button is pressed during “ALERT” is displayed on the screen. The contents

of last 16 warnings are stored and can be displayed. The contents older than them are cleared and output of CALL OUT is
cancelled. CALL OUT signal output can be stopped by pressing the E button or clicking “Clear Warning” while displaying

the warning display.

Warning Display Countermeasure Cancelling || o humber cﬁhlt-pzw
the warning #1
The remaining capacity of Normal Area » Copy data as necessary. Click "Clear |LOG1200 Selectable
in Main device has become less than **%.#2 Warning" or
The remaining capacity of Alarm Area press the E | LOG1201
in Main device has become less than **%.#2 button.
The remaining capacity of LPA Area LOG1202
in Main device has become less than **%.#2
The remaining capacity of Copy 2 disk LOG7200
has become less than **%.#2
The remaining capacity of Normal Area * When the warning is cancelled, | Click "Clear |LOG1100#3 [Selectable
in Main device has become 0%. the unit starts overwriting the Warning" or [ LOG4100#4 |None
The remaining capacity of Alarm Area oldest data remaining in the press the E | LOG1101#3 |[Selectable
in Main device has become 0%. HDD. button. LOG4101#4 [None
The remaining capacity of LPA Area » Copy data as necessary. LOG1102 Selectable
in Main device has become 0%.
The remaining capacity of disc in Copy 1 * Replace media if necessary. Click "Clear [LOG3100 None
drive has become 0%. Warning" or
The remaining capacity of disc in Copy 2 press the E | LOG7100 Selectable
drive has become 0%. button.
Copy data size error. « Set the copy/restore range again.| Click "Clear |LOG3701#5 |None
* Replace with new media. Warning" or | LOG7701#6
Check the range of copy data or the disk space press the E |LOG4701#4
of copy media. button.
Copy media error. * Check that media is in the Click "Clear |LOG3702#5 [None
recording device. (If not, insert Warning" or | LOG7702#6
Cannot copy the data. the media.) press the E [LOG4702#4
Check the copy device. + Check whether that the write-protect| button.
of the media is enabled. If so,
cancel the protection.
« After turning off the power of the
peripheral recording device and
the unit, reboot in order of
peripheral recording device and
the unit.
* After turning off the power of the
peripheral recording device and
the unit, check a cable.
* Replace the disc.
No disk. * Insert the disc. Click "Clear |LOG3703#5 |None
* Replace the disc. Warning" or [LOG7703#6
The drive has no disk or wrong type of disk. press the E |LOG4703#4
Put a proper disk into the drive. button.
The remaining capacity of disc in Copy 1 * Replace the disc. Click "Clear [LOG3704#5 |None
drive has become 0%. Warning" or
Put a new disk into the drive. press the E
The remaining capacity of disc in Copy 2 button. LOGT7704#6
drive has become 0%.
Put a new disk into the drive.

#2 : The value depends on the setting. #7 : (The following numbers are entered in[J[1) #8

01:CH1
05:CH5
09:CH9

#3 : Log number for recording
#4 : Log number for restore
#5 : Log number for copy 1
#6 : Log number for copy 2

02:CH2 03:CH3 04:CH4
06:CH6 07:CH7 08:CH8
10:CH1011:CH11 12:CH 12

13:CH1314:CH1415:CH 15 16:CH 16

:1300,1400: Recording
3300,3400: Copy 1
7300,7400: Copy 2
(The following numbers are entered in[1[1)
00: A(Internal) 01 : B (Internal)

10 to 25 : USB (External)

2300,2400: Playback
43[]0,4400: Restore




CALL OUT

. . Cancelling
Warning Display Countermeasure the warning Log number °uﬁm
No Camera Signal » Check whether the unit and Stop recording. | LOG54[[1#7 |Fixed
camera are properly connected
Camera signal is lost or distorted. and turned on.
Please check the camera and cable » Check whether the video signal is|Output video
connection. being properly outputted. signals.
 Check whether the camera with | Click "Clear
no video signal input is set for Warning" or press
operation. the E button.
It can use as it is though a slight error  Continue the operation when Automatically LOG13[0#8 |None
occurred. there is no abnormality. clears after 1 LOG33004#8
* When the error occurs minute. LOG4300#8
continuously, check the LOG7300#8
HDD/media and cable and then LOG23[0#8
restart the unit.
System suspended due to unstable « Start operation again. Click "Clear LOG1400#8 |Fixed
processing. Recording will be resumed. * Turn the power on again using Warning" or press
HDD 3 % % * was disconnected. POWER button on the front the E button.
System suspended due to unstable panel. LOG7400#8
processing. Start operation again. * Turn the power on again using Automatically LOG24[][J#8 [None
MAIN switch on the rear panel. |clears after 1 LOG34[[]#8
minute. LOG44000#8
The recorder detected the data altered or data Click "Clear LOG55[0#7 |None
recorded by other recorder. _— Warning" or press
the E button.
Recorder detected technical problems Click "Clear LOG6200 Fixed
on the device. - Warning" or press
the E button.
The recorder has been rebooted. The problem|s Check the unit. Click "Clear LOG5100 Fixed
is not critical, but check the recorder. Warning" or press
the E button.
Internal temperature is getting too high, « Turn off the power and change  |Click "Clear LOG5200 Fixed
check the ventilation of the recorder. the installation condition. Warning" or press
the E button.
Internal temperature is getting too high, « Turn off the power and change  |Click "Clear LOG5201 Fixed
stop the operation of the recorder the installation condition. Warning" or press
immediately. the E button.
Lower the
temperature.
The fan of the recorder needs to be checked. |* Turn off the power and stop Click "Clear LOG5300 Fixed
using. Warning" or press
the E button.
Rotate the fan.
Copying data stopped because of new record |+ Stop HDD recording to continue |Click "Clear LOG3500#5 |[None
overwrites the old data. copy/backup. Warning" or press | LOG7500#6
the E button.
New record will soon overwrite the old data |+ Stop HDD recording to continue |Click "Clear LOG3600#5 [None
in copying. copy/backup. Warning" or press  |LOG7600#6
Stop the recording, if you want to continue the |* Stop copy/backup to continue the E button.
copying. HDD recording.
(NONE) * Restarts by watchdog operation LOG5101 —
or for self-recovery. E— LOG5102
LOG5103

#Regarding LOG14[0: Displays during recording. The system shuts down once and then resumes recording. (The error HDD is

automatically deleted from the recording device. The recording is continued until all the registered HDDs are used up.)

#Regarding LOG24 [10 to 7400: Displays during copying or playback. The playback or copy stops because the system shuts down.

Carry out playback or copy again.

#Regarding LOG 54[J0: Displays during recording when the video signal is not existed for the camera being recorded for 2 seconds

or more. This warning may not be displayed for the recording of which recording time is less than 2 seconds.

Warnings and CALL OUT output
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